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1.  Introduction 

System Navigator is a family of JTAG-based debugging solutions.  There are currently two 
hardware/software solutions: 

 System Navigator 

 System Navigator, Original Edition 

System Navigator, pictured on the left, communicates with USB (1.1 and 2.0) and supports Ethernet 
as an orderable option.  Multiple cores and tools on a single JTAG chain can be controlled.  Multiple 
System Navigators can also be controlled with a single software session. 

System Navigator, Original Edition (OE) pictured on the right, communicates with a parallel port and 
does not support USB. 

 

 

 

 

 

 

 

2.  Mentor M8051EW Cores 

 

The M8051EW cores from Mentor Graphics Inventra are supported by both hardware probes. 

Both probes have a choice of cable options: 

 EJTAG (4-wire) 

 FS2DI (2-wire) 

EJTAG has a 4-wire chip interface.  FS2DI stands for as First Silicon Solutions Debug Interface and 
is a 2-wire serial interface. 

When the FS2 software starts, a Connection dialog displays.  Choose your probe type (System 
Navigator or OE), communications port (USB, Ethernet, parallel port), and the cable type (EJTAG, 
FS2DI). 

The Connection dialog is generic for all FS2 products.  Several configuration options do not apply to 
the M8051EW: OE USB and Mictor cable. 

3.  Quick Start 
 

The System Navigator Quick Start Guide contains information on setting up the hardware and 
software.  Read it first to assure the hardware and software are configured properly.  The System 
Navigator Quick Start Guide requires a configuration file.  If you are using a single core, the 
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m8051ew-single-core configuration is supplied.  If you are using a multi-core setup, see the System 

Navigator Quick Start Guide for information on creating a new configuration file. 

4.  Software Interfaces 

 

FS2 Console 

FS2 provides a command-line interface (CLI) based on Tcl/Tk.  See the section Console 
Commands and Syntax Conventions for more information and tutorial. See the online help for a 

complete listing of M8051EW specific commands. 

FS2 Source-level Debugger 

FS2 provides a very simple graphical user interface (GUI) source-level debugger.  It loads OMF 
files with debug information and supports line numbers and globals.  This allows simple source 
level debug.  Local variables, structures, and other complex types are not supported.  See the 
section FS2 Source-level Debugger for details. 

Keil Source-level Debugger 

FS2 supports Keil uVision2 and uVision3.  See the section Keil Source-level Debugger for details. 

5.  Hardware 

This section discusses hardware issues for System Navigator and System Navigator, Original Edition 
(OE).  Choose the appropriate section for your probe. 

See the System Navigator Quick Start Guide for general information on connecting the hardware. 

5.1.  System Navigator Hardware 

5.1.1.  Target Connection for EJTAG (4-wire) Cable 

The System Navigator uses a 10-position flat ribbon cable with standard 0.100” square post 
headers.  A connector with an orientation key such as 3M 2510-6002UB is recommended.  The 
pinout of the target connector is described in the following table. 

TCK   1 2   GND 

TDO   3 4   VCC 

TMS   5 6   VIO 

TrigOut   7 8   RESET 

TDI   9 10   GND 
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Pin Signal I/O Active Comments 

1 TCK O H JTAG test clock 

2,10 GND -- -- Signal reference.  Both pins must be connected. 

3 TDO I H JTAG test data output 

4 VCC   Probe does not connect to this pin. 

5 TMS O H JTAG test mode select 

6 VIO I -- Used by probe to configure output driver level.   

7 TrigOut O H Optional Trigger Out signal from OCI 

8 RESET I/O H/L Bidirectional reset.  Asserted from probe to force target 
reset and asserted by target to indicate an OCI reset. 

9 TDI O H JTAG test data input 

 

A typical system implementation of the debugger interface is shown in the following schematic. 
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 The pullup on TCK insures that the OCI is disabled when the debugger is not plugged into 
the target.   

 TCK is an edge-sensitive signal and should be routed carefully to avoid problems with 
transmission-line effects or crosstalk. 

 RESET may be active-high or active-low.  The Connection dialog configures the logic sense 
and drive characteristics of this signal.  The target must provide any necessary 
pullups/pulldowns. 
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5.1.2.  Target Connection for FS2DI (2-wire) Cable 

The System Navigator uses a 10-position flat ribbon cable with standard 0.100” square post 
headers.  A connector with an orientation key such as 3M 2510-6002UB is recommended.  The 
pinout of the target connector is described in the following table. 

SCLK   1 2   GND 

NC   3 4   VCC 

NC   5 6   VIO 

TrigOut   7 8   RESET 

SDAT   9 10   GND 

 

Pin Signal I/O Active Comments 

1 SCLK O H FS2DI test clock 

2,10 GND -- -- Signal reference.  Both pins must be connected. 

3 NC   Target should not connect to this pin. 

4 VCC   Probe does not connect to this pin. 

5 NC   Target should not connect to this pin. 

6 VIO I -- Used by probe to configure output driver level.   

7 TrigOut O H Optional Trigger Out signal from OCI 

8 RESET I/O H/L Bidirectional reset.  Asserted from probe to force target 
reset and asserted by target to indicate an OCI reset. 

9 SDAT I/O H FS2DI bidirectional data signal 

 

A typical system implementation of the debugger interface is shown in the following schematic. 
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 SCLK is an edge-sensitive signal and should be routed carefully to avoid problems with 
transmission-line effects or crosstalk. 

 RESET may be active-high or active-low.  The Connection dialog configures the logic sense 
and drive characteristics of this signal.  The target must provide any necessary 
pullups/pulldowns. 



Getting Started  System Navigator for Mentor M8051EW  

Copyright (c) 2005-2007 MIPS Technologies, Inc.  All rights reserved. Page 8 of 38  

5.2.  System Navigator, Original Edition (OE) Hardware 

This section details hardware specifications for the System Navigator, Original Edition (OE) probe. 

See the System Navigator Quick Start Guide for general information on connecting the hardware. 

5.2.1.  Target Connection for EJTAG (4-wire) Cable 

The System Navigator OE target cable is a 9-inch, 20-position flat ribbon cable with a keyed AMP 
System 50 receptacle, mating to AMP connector 104549-2 (vertical surface mount), 104069-1 
(right-angle through-hole), or 104068-1 (vertical through-hole).  The pinout of the target connector 
is described in the following table. 

Pin Signal I/O Active Comments 

2 DBRESET O High Driven high by debugger to reset target system.  
Typically hooked into the target power-on reset 
circuitry. 

3 RESET I High Input to debugger informs debugger that a target 
reset has occurred.   

5 TriggerOut I High Optional Trigger Out signal from the M8051EW. 

6 VCC I -- Used by debugger to determine target power-on 
state.  The debugger does not draw significant 
current from this pin. 

7 RTCK I High Optional return TCK. 

12 TDI O High JTAG signal 

13 TDO I High JTAG signal 

14 TMS O High JTAG signal 

16 TCK O High JTAG signal.  The signal should be pulled up to 
disable the OCI when the debugger is not 
connected. 

18 TRST# O Low Optional JTAG signal (not used by M8051EW) 

19 DBINST# O Low Driven low by the debugger. 

20 BSEN# O Low Driven low by the debugger. 

4,8,10, 
15,17 

GND -- -- Signal reference 

1,9,11 N/C -- -- Target should not connect to these pins. 

 

Interface levels on the debugger connector are 3.3V TTL.  Debugger inputs must be driven below 
0.8V for logic 0 and above 2.0V for logic 1.  Debugger outputs actively drive signals up to 3.3V.  
ASIC inputs must be able to accept 3.3V input levels or the target needs to have level shifters 
between the debugger and ASIC. 

There is a keying notch on the connector to prevent mis-insertion, and the pins are numbered 
sequentially along the short axis of the connector, as follows (top view): 

1

2

19

20
 

A typical system implementation of the debugger interface is shown in the following schematic. 
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 The OR gate in the RESET path can be part of the reset supervisor or can be included in the 
ASIC. 

 The pullup on TCK insures that the OCI is disabled when the debugger is not plugged into 
the target.   

 TCK is an edge-sensitive signal and should be routed carefully to avoid problems with 
transmission-line effects or crosstalk. 

 An additional optional connection, RCK, between the ASIC and debug connector may be 
used in conjunction with config UseRtck to throttle JTAG traffic. 

5.2.2.  Target Connection for FS2DI (2-wire) Cable 

The System Navigator OE-2W target cable is an 18-inch, 10-position flat ribbon cable that mates 
with a standard double-row square pin header such as 3M 2510-6002UB.  The pinout of the 
target connector is described in the following table. 

Pin Signal I/O Active Comments 

1 VCC I -- Used by debugger to determine target power-on state.  

2 TrigOut I High (optional) TrigOut signal from OCI.  If unused, connect 
to GND. 

3 GND -- -- Signal reference 

4 SDAT I/O High Bi-directional FS2DI data signal 

5 GND -- -- Signal reference 

6 nRESET I/O Low Bi-directional signal.  Driven low by the debugger to 
reset target system.  Sampled by debugger to detect 
target reset events.  A pullup is typically included within 
the ASIC or at board level. 

7 GND -- -- Signal reference 

8 SCLK O High FS2DI clock signal 

9 GND -- -- Signal reference 

10 DBINST O High Driven to logic 1 by the debugger.  Could be used to 
control board-level circuitry that depends on whether the 
debugger is connected. 
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Interface levels on the debugger connector are 3.3V TTL.  Debugger inputs must be driven below 
0.8V for logic 0 and above 2.0V for logic 1.  Debugger outputs actively drive signals up to 3.3V.  
ASIC inputs must be able to accept 3.3V input levels or the target needs to have level shifters 
between the debugger and ASIC. 

There is a keying notch on the connector to prevent mis-insertion, and the pins are numbered 
sequentially along the short axis of the connector, as follows (top view): 

1

2

9

10

 

A typical system implementation of the debugger interface is shown in the following schematic. 
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 SCLK is an edge-sensitive signal and should be routed carefully to avoid problems with 
transmission-line effects or crosstalk. 

5.2.3.  JTAG IR Bypass Support (System Navigator OE only) 

The System Navigator OE supports a configuration item called JtagIRBypass, which allows a 

bypass instruction to be given for a device in the JTAG chain. 

The config JtagIRBypass command is a comma-separated list of IR values to select Bypass on 

each core.  Unspecified items default to -1 (all 1's). 

Example usage: 
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 Assume a JTAG chain of  TDI -> controller -> flash -> M8051EW -> M8051EW -> TDO.  
The IR length of the controller is 4 bits, the flash is 4 bits, and each M8051EW is 8 bits. 

 Assume the Bypass instruction of the controller is binary 1000 and Bypass of all others is 
the standard all-ones. 

 The jtag chain is specified from TDO to TDI and is “8,8,4,4”. 

  The config JTagIRBypass command is also specified from TDO to TDI and would be: 

o config JtagIRBypass -1,-1,-1,8 

Restriction:  If JtagIRBypass has any specified items (not all defaulting to -1), the JTAG chain 
must be a multiple of 8 bits.  If cores other than M8051EWs are on the chain, then the total IR 
length of those cores must be a multiple of 8.  If that is not the case, then the OE cannot be used.  
The above example of “8,8,4,4” is 24 bits, a multiple of 8 and therefore supported. 
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6.  Keil Source-level Debugger 

6.1.  Introduction 

The M8051EW debugger interfaces to the Keil uVision2 and uVision3 software by adding a hardware 
driver to the list of available tools in Keil‟s tools.ini file.  Upon starting the uVision software, this driver 

can be selected and used to debug code with the FS2 debugger. 

All Keil source level debug features work with FS2‟s hardware – go, step, halt, view/edit registers, and 
view/edit memory.  In addition, new menu items access FS2‟s unique trace, trigger, and command 
line interface (Console) windows. 

Warning:  If you have both uVision2 and uVision3 installed, depending on where you installed each 
product, the hardware driver may not be installed in both.  If you have 2 tools.ini files, one will not be 
updated.  Check the tools.ini file‟s [C51] section for the hardware driver.  To add a driver if missing,  

paste the following line into the [C51] section of tools.ini: 

TDRV3=C:\PROGRA~1\Fs2\m8051ew\Bin\fs2keil51.dll ("FS2/Keil M8051EW Driver") 

Note:  The “3” in TDRV3 may be different for your configuration.  The number should be the next 
available number in the driver sequence.  Also, if you did not install into the default FS2 directory, 
change the path to point to your directory. 

6.2.  Setting Up the Debugger Hardware 

If this is your first time using the FS2 Debugger, see System Navigator Quick Start Guide to install 

your hardware. 

If you have already set up your hardware from a previous installation, no further hardware set up is 
needed.  To install the software, see System Navigator Quick Start Guide. 

6.3.  Setting Up Keil Software 

To get the most out of the Keil compiler, you should turn on the symbolic debug features. The 
compiler defaults typically do not include these settings.  They should be set for each new project 

since they are not the defaults. 

Consider setting the compiler options as follows: 

 Under Project/”Options for Target”, go to the "Output" tab and select “Create Executable” and 
"Debug information". 

Under Project/”Options for Target”, go to the "C51" tab and select "Level 0: Constant Folding…".  This 
turns off almost all the optimization.  If you leave it at the default (level 8, the most optimization), you 
may find it hard to correlate a line of source with "where" it is really being executed.  (For example, a 
line like "a=5;" may not set the variable "a" to 5 until it is really needed, which could be many lines 
later.  You will often see no source indicator ("-") on the source lines where you expect to see code.)  
After you debug your program, you can raise the optimization level, if appropriate for your application. 

6.4.  Choosing the FS2 Driver for Keil 

Start Keil‟s uVision software.  To choose the FS2 Keil driver: 

 Turn on the FS2 debugger and then your target. 
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 Select the Project menu. 

 Select the Choose Options for Target „<name>‟ menu item. 

 Click on the Debug tab. 

 Select the Use button on the right side and select the FS2 driver from the drop-down 
listbox.  Choose FS2/Keil M8051EW Driver: 

 

 
 

 Select options you may want.  Typically, Load Application at Startup is selected and Go 
till Main is selected if your startup code is debugged. 

 Select the Settings tab and configure the hardware if you have not already. 
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 Choose Cancel.  All settings will be saved.  You will have another opportunity to open a 
Console session when you start debugging. 

 

6.5.  Starting a Debug Session 

To start a debug session: 

 Select the Debug menu. 

 Select the Start/Stop Debug Session menu item. 

 The Console Connection dialog will display.  Choose OK to start a Console session. 
 

Once a Keil debug session is started, new menu items appear in the Peripherals menu: 

 FS2 Trace. View the trace for the last emulation session. 

 FS2 Triggers.  Set complex triggers and view current settings. 

 FS2 Console Interface.  Full access to the FS2 debugger with macros.  Use the Help 
menu for details.  Memory and register changes in the Console are not reflected in the 
Keil windows until the next emulation halt.  Any changes in Keil will be reflected, 
however, in the Console. 

 FS2 Help.  Access the online help file. 
 

6.6.  Getting Started Issues 

Here are some possible start up problems and suggestions: 
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 If you do not see the FS2 hardware driver in the Use listbox, the software was not 
installed properly.  The drivers must appear in the „tools.ini‟ Keil file in the root directory 
where you installed Keil.  Be sure this file is writable.  If you installed Keil after the FS2 
software, you will have to re-install the FS2 software. 

 If you get an error selecting Settings in the Debug tab, a DLL is probably missing.  Re-
install the FS2/Keil Driver. 

 If you get an error starting a debug session when you choose the Start/Stop Debug 
Session menu item, try the following: 

o Go back to the Options/Debug tab and remove the selection of Load Application 
at Startup and Go till Main.  Try starting the session again.  If it now works, the 
Driver installation is okay but there is an issue with your code loading. 

o If you still have an error, go back to Options/Debug tab once more.  Click on the 
Settings button.  If it fails also, you have an installation problem.  Re-install the 
FS2 software.  If Settings works, you have a code loading problem.  Typically, 
de-selecting Load Application at Startup should resolve this issue. 

o If all else fails, choose the Use Simulator (left side of the Debug tab) and make 
sure a simple Keil example like Hello loads correctly.  You may have a Keil 
uVision installation problem. 

 
 

6.7.   Code Banking Configuration  

In order to properly support code banking in Keil uVision software, please make sure to follow these 
steps for your project. 

 Under “Options for Target”, in the “Device” tab, please make sure to check the “Use Extended 
Linker(LX51) instead of BL51”.  (Shown Below)   
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 Under the “Listing” tab ,  please make sure to check the “Linker Listing” check box as show 
below. 

 

 

 After you have made the above changes,  perform a “Rebuild” your project.  Please verify that 
your project directory now contains a .MAP file. (i.e. MyProject.map).  The FS2 debugger uses 
the map file to gather information about your banking setup.  If it is not present, you will not 
achieve expected debugging behavior for your “banked code”. 
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Every time you begin a debug session, there are some “banking” log messages that are output in the 
COMMAND window at the very beginning of each session.  Here is an example output. 

@@@@@@@@@@@@@@@@@@@@@@@@@@@@ 
Banking Setup Procedure START 
APPLICATION NAME = FS2Bank  
### FOUND BANKING INFO IN BINARY EXE FILE  
nMode = 0  
nMask = 3  
nCtrlReg = 96  
+6: SysNav has bank settting at: 'off' 
+7: KEIL is setting bank to 3 96 96   
@@@@MAP FILE INFORMATION: 
@@@@Common address MIN  = 0x3  
@@@@Common address MAX  = 0x235  
#### BANK DATA SETUP SUCCESFULLY !!!!!  
Banking Setup Procedure END  
@@@@@@@@@@@@@@@@@@@@@@@@@@@@ 
 
Please make a note if you see any error messages during this period. 
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6.8. Flash Programming with Keil 

In order to program your flash memory through the Keil IDE you must first setup a few configuration 
settings. 
 

 In the system navigator, setup the “flash” configuration item to your flash memory type.(see 
below).  This should be a one time setting.  If you have used the System Navigator to flash your 
device already, this setting should already be setup for you.  

 
 
 
 

 In the same menu, if it is not already there, create a new configuration item called “ Flash_Device 
” – NOTE: it is case sensitive.  Set the value of this item to the following. 

8051 Core  --  Value of “Flash_Device” configuration Item 
 
PHILIPS    --      PHILIPS 
MENTOR  --      MENTOR 
CAST       --       CAST 
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 Next, you need to create FlashMap.txt file, which must be located at ”C:\”.  This file describes the 
sector layout of your flash device so that our software knows how to erase the device sector by 
sector.    

 
FlashMap.txt Examples: 
1) Non banked project (< 64K)  (Flash device …. has sectors that are 0x1000 in size) 
 

0,0x00001000 
0,0x00002000 
0,0x00003000 
0,0x00004000 
0,0x00005000 
0,0x00006000 
0,0x00007000 
0,0x00007FFF      last address of device 

 
 
 
2)  Mbm29lv400as flash device,  project is setup to use code banks that are 64K in size 

     
0,0x00000000    
0,0x00010000    
0,0x00020000    
0,0x00030000    
0,0x00040000    
0,0x00050000    
0,0x00060000    
0,0x00070000    
0,0x00078000    
0,0x0007A000    
0,0x0007C000    
0,0x0007FFFF        
 
3)  Mbm29lv400as flash device,  project is setup to use code banks that are 32K in size ( 2 code 
banks per sector in this case).   
 
0,0x00000000 
0,0x00828000 
0,0x00848000 
0,0x00868000 
0,0x00888000 
0,0x008A8000 
0,0x008C8000 
0,0x008E8000 
0,0x008F8000 
0,0x008FA000 
0,0x008FC000 
0,0x0007FFFF 
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Please note that the last entry is not a sector start address, but the last address of the device. 

. 
       Example 3 above was derived from the product spec using the following calculation.   
       Start and End address are the same as spec, rest of sectors use the following: 
 
       Temp1:  Temporary Variable 
       SectorValue:  Sector start address. 
       BankValue:  Result value for that sector. 
 
 
    Temp1 = SectorVal & 0xF000; //hold for later 

            BankValue = SectorVal & 0xFF0000; // 

            BankValue *= 2; 

            if (Temp1 > 0) 

                BankValue += 0x10000; 

 

            BankValue |= 0x8000; 

            BankValue |= Temp1; //or in temp values now 

         BankValue |= 0x800000; 

 

 

 
Please create a file named FlashMap.txt with the above information for your specific flash device and 
configuration.   
Place the file at C:\ 

 
 

 In Keil, open the Options for Target „Your Target‟ dialog.  Under the “Utilities” TAB, select  
“Use Target Driver for Flash Programming”,  and make sure you select FS2/Keil _”core”_8051 Driver 
from the device list. 

 

 Click the Settings button to right of the device list, you should see a dialog like this. 
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NOTE:  There are currently two sections: (base address/load address) which are not enabled for use.  
These may be enabled at a later date.  Please ignore them. 
 
 
Code Banking Setup – Please see Keil Help for the correct setting.  Keil shows two examples in the 
help, under LX51 “code banking”.  If you are not use code banking, please set this to off. 
 
Erase Operation – Select either to erase the entire device or a sub section of sectors.   
NOTE:  An Erase operation is done every time a flash “download” or “erase” is selected.  The 
erase operation will follow your setting here(chip or sectors ). 

 
Example of flash downloading a program.  
 

 In Fs2 Flash config menu , select “Erase Entire Device” 

 Press OK, and exit Keil‟s Options dialog. 

 In Keil, select  the Flash pull down menu, and select DOWNLOAD. 
 

You should see the System Navigator show up, go away,  then the Keil progress bar at the bottom of 
the Keil window along with some log messages perhaps. 
Flash programming is complete when the progress bar has passed 100%. 
With this example, the entire device was first erased, and then programmed according to Keil locater 

 
Example of Erase Device operation. 
 

 In Fs2 Flash config menu , select “Erase Entire Device” 

 Press OK, and exit Keil‟s Options dialog. 

 In Keil, select  the FLASH pull down menu, and select ERASE. 
 

You should see the System Navigator popup, go away.  
In this example, the entire device was erased.,  Nothing was programmed.  

 
 

Example of Protecting sectors for flash Erase 
 

 In Fs2 Flash config menu , select “Erase Selected Sectors” 

 Select the sectors you want to protect/erase (NOTE: you cannot select the last entry) 

 Press OK, and exit Keil‟s Options dialog. 

 In Keil, select  the FLASH pull down menu, and select ERASE. 
 

This example will erase only the sectors you selected 

6.9. Trace Recording with Keil 

Keil IDE support a trace recording feature.  There are two buttons on the main toolbar that support 
this feature.   
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To use, press the record trace button when the application is halted.  Hit run, and on the next 
halt/break, press the View trace button.  The trace data should appear in the disassembly window 
above your PC(in Grey).  You can view up to 1024 operations.  Please contact FS2 if you have a 
need to view more operations (more history). 
If the record button is not pressed, no trace history is recorded, and cannot be displayed.  

 

 

 

 

 

 

6.10.   Tutorial 

This is a quick tutorial using a sample program supplied by FS2.  It resides in the Samples sub-

directory (default c:\Program Files\Fs2\m8051ew\Samples): 

 start Keil uVision software 

 choose Project menu, item New Project…. 

 Browse to the Samples directory and enter FS2.  This will create a project file named 
FS2.uv2. 

 The next screen prompts for the CPU.  Choose Mentor, then M8051EW, or whatever 
chip is appropriate for your target board. 

 A query Copy Standard 8051 Startup Code to Project Folder and Add File to Project? 
may appear.  Say No since we will not use Keil‟s start-up code. 

 Choose Project menu, then Components, Environment, Books….  Choose Project 
Components tab, Add Files button, and add Fs2Func1.c, Fs2Func2.c, and Fs2Func3.c.  
The file, fs2.c, should already be part of the project.  If not, add it also. 

 Choose Project menu, Options for Target „Target 1‟.  Under the Debug tab, select the 
right hand side Use radio button and select FS2/Keil M8051EW Driver from the 
dropdown.  Select Load Application at Startup and Go till main().  Click OK. 

 Choose Debug menu, Start/Stop Debug Session to start the session. 

 The program should run to main (the line globalx = 0x11 should have the yellow arrow 
next to it. 

 Choose Debug menu, then Step.  The yellow arrow moves to the next line.  If you have 
the Register window open, the PC is updated. 

 If you move the cursor over globalx, the value 0x11 appears. 

Record Trace Button View Trace Button 
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 Choose Peripherals, then FS2 Triggers.  Under Trigger1, select Single.  Under 
Address, select Enable and enter 0x51 for the address.  Choose Close to exit. 

 Choose Debug, then Go to start free run.  The trigger will be hit and the PC will show 
0x53 (some slippage is common for triggers, unlike software breakpoints). 

 Choose Peripherals, then FS2 Triggers.  Under Trigger1, select Off. 

 Choose Debug, then Go.  This time, no trigger is hit.  Choose Debug, then Stop 
Running to halt. 

 

 

 

 

7.  FS2 Source-level Debugger 

7.1.  Compiler Set-Up 

The M8051EW software supports assembly-level and source-level debugging.  Code can be loaded 
in Hex or Binary formats for assembly-level debug.  For source-level debug, the Intel OMF51 format 
is used.  The software supports standard OMF51. 

Standard OMF51:  Many compilers support the standard OMF51 format.  The standard format 
supports line numbers (so you can step, goto, etc.) and global variables.  You cannot directly view 
structures, pointers, and arrays.  (Use the CPU memory area for this.)  Variable names in standard 
OMF51 are not case-sensitive. 

 Keil Extensions:  FS2 does not support Keil extensions.  See the section Keil Source-level 
Debugger for information on using the Keil debugger 

Keil variable names, unlike standard OMF, are case sensitive.  Module names are all uppercase and 
variables are exactly as they appear in your program.  So, "tempVar", "tempvar" and "Tempvar" are 
all unique names. 

Note:  Banked code memory programs are supported.  See the online help for information. 

7.2.  Tutorial 

The tutorial will demonstrate the basic debug features of the source-level debugger.  Each section is 
written so it can be run independently.  The tutorial should take less than an hour. 

We will: 

 load a program, 

 step and go/halt, 

 set breakpoints, 

 view variable values, 

 look at the symbol table 

 use trace and triggers 

 view the CPU registers and memory 
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If you have changed any Config menu items, be sure to reset these values to their default value by 
deleting the initsettings.tcl file in the installation directory. 

Now, let's get started by starting the software: 

 From the Start Menu, choose Programs, then FS2, then the System Navigator 
Console. 

 When the debugger starts, choose Source-level Debugger from the Windows menu. 

 The Source window will appear. 

 If you want the Source window to automatically start each time, enter the following 
Console command:  sysnav config sysnav-m8051ew-system-settings autostartsld 1 

 

7.2.1.  Using the Source Window 

This step will load a program and use the basic emulation commands. 

Load a program: 

 Choose the Tools menu, Load OMF… option. 

 The default filename should be c:\Program Files\Fs2\M8051EW\samples\fs2.  If not, 
you should reset to the default values by deleting the initsettings.tcl file in your installation 
directory.  If you installed the software in the default directory, use this value.  Otherwise, 
use the Browse command to find the "fs2" file 

 The "fs2" file (without an extension) is a Keil OMF file.  It contains full debug information 
for our tutorial program. 

 Click OK.  You will see a pop up telling you that the code and debug information loaded 
successfully.  Click OK. 

 The CPU will be reset and the code will run until the main program.  The CPU is reset 
because the Reset CPU on Load option in the Config menu is chosen.  Likewise, it runs 
to main because Run to Main on Load is chosen. 

 
Looking at the Source window: 

 There are buttons across the top for the common functions.  There are also function keys 
as shown in the Utilities menu for each of these. 

 The status bar at the bottom shows whether it is Ready or Executing a command, the 
Running/Halted processor status, and at the right side, the name of the current module 
which is FS2 (because the source file is called FS2.c). 

 
Single stepping: 

 You should be on line 31. 

 Single step by clicking the Step Into button. 

 You are now on line 32. 

 Notice that the PC line is in red and is underlined.  There is also a ">" character on the 
left side to indicate the PC line. 

 
There are different view modes: 

 Choose the Config menu Mixed Source/Assembly option. 

 Two lines now indicate the PC line: the source line and the 1
st
 assembly line for line 32. 

 The assembly code for line 32 indicates that the variable globaly is a word (int) at 
address 0x28i.  This agrees with its declaration on line 20. 

 Choose the Config menu Source option to go back to source only view mode. 
 



Getting Started  System Navigator for Mentor M8051EW  

Copyright (c) 2005-2007 MIPS Technologies, Inc.  All rights reserved. Page 25 of 38  

Using Go To Cursor and breakpoints: 

 Move the cursor to the source code on line 36.  Click the right mouse button.  A context 
menu appears.  Choose Go To Cursor.  (Instead of using the right mouse, you can also 
use double-click.) 

 The processor free runs (go) to the cursor and is now on line 36.  The status bar says 
Software breakpoint because a temporary breakpoint was used in the Go To Cursor 
operation. 

 Set a breakpoint on line 42 by double-clicking on the "42".  The line will appear in blue 
and a "b" will be shown at the left side. 

 Choose the Go button to run to the breakpoint. 

 Notice the PC is on line 42 as indicated by the underline and the ">".  It is blue, however, 
because of the breakpoint.  The "b" also indicates a breakpoint and the "-" on this line 
(and others) indicates there is source code associated with the line. 

 Remove the breakpoint by double-clicking the "42" again.  It toggles the breakpoint off. 
 

Step over a subroutine: 

 Choose the Step Over button. 

 The processor runs the entire func1 subroutine and breaks on line 43. 
 

7.2.2.  Inspecting Variables 

This step will load a program and use the basic emulation commands in the Source window. 

Let's load the program again, which will also reset the processor and bring us to the start of the main 
procedure: 

 Choose the Tools menu, Load OMF… option. 

 Use c:\Program Files\Fs2\M8051EW\samples\fs2 or wherever you installed the 
software. 

 Click OK.  You should be at line 31, the beginning of main. 

 Double click on the variable name globalx on line 31. 

 It's value is 0x00 (it‟s a char).  Click Yes to add it to the watch window. 

 The Watch window appears.  Move it around so you can see both windows.  Using the 
Tile Windows Vertically option on the Windows task bar is helpful.  (Right click the task 
bar in a "background" area and choose the option.  You may have to minimize your other 
windows to obtain a better view of the Source and Watch windows.) 

 Click the Step Into button.  You are now on line 32. 

 The Watch window shows that globalx is now 0x11, as the code dictates. 

 Double click on globaly on line 32 and click Yes to add it to the Watch window. 

 Double click on globalz on line 33 and click Yes to add it to the Watch window. 

 Click the mouse on line 35 and choose the Go To Cursor button. 

 You are now on line 35 and the Watch window shows the new values. 

 Double click on variable a on line 35 and click Yes. 

 Notice the name of the local variable is ::C::FS2::MAIN::BLOCK1::a.  The ::C is a Tcl 
namespace convention.  ::FS2 is the module.  ::BLOCK1 is a Keil debug scope indicating 
the first block (first set of curly ({}) braces) in the module.  And, a is the variable, which is 
case-sensitive for Keil.  It is not case-sensitive for standard OMF51. 

 Click the Step Into button and notice that the variable values are updated. 
 

Editing variables: 

 In the Watch window, click on the variable a line. 
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 Choose the Utilities menu, then Edit Watch… option. 

 The current value is shown.  Type 2 as the new value and then click OK. 

 The variable is updated.  You can also double-click on a line or use the context menu 
(right mouse) to choose edit and other options. 

 Close the Watch window by choosing File, then Close.  You can also use the window‟s 
close button (the X in the upper right corner). 

 

7.2.3.  Exploring Symbols 

This step will show how to use the Symbol Explorer. 

Load the program again, which will also reset the processor and go to the start of the main procedure: 

 Choose the Tools menu in the Source window, then the Load OMF… option. 

 Use c:\Program Files\Fs2\M8051EW\samples\fs2 or wherever you installed the 
software. 

 Click OK.  You should be at line 31, the beginning of main. 
 

View symbols: 

 Choose Windows and then Symbol Explorer to bring up the new window. 

 You will see "+ C".  This is an expandable/collapsible tree. 

 Double click on the "+ C" line.  The "+" changes to a "-" to indicate it is now expanded to 
show the top level modules (FS2, FS2FUNC1, FS2FUNC2, FS2FUNC3) and the globals. 

 Double click on the <globals> line.  This is an alphabetized list of all globals.  Four of 
them are functions (_func1, _func2, _func3, and main) with their addresses and 6 are 
global variables (all starting with the word global) with their current values. 

 
View local variables: 

 Double click on the FS2 module line. 

 Double click on the function MAIN. 

 Double click on BLOCK1 on the line just after main.  This is the first block noted by the 
first set of curly braces ({}) in the MAIN function. 

 Finally, double click on <variables> to see 3 local variables: a, b, and c.  We are at the 
beginning of the program so their current values are zero. 

 Double click on the 2
nd

 BLOCK1 and double click <variables> under this.  Notice the 
indentation level indicates this BLOCK1 is a sub block of the first BLOCK1.  If you look at 
the Source window, variable loopx is declared on line 41 inside the while loop, which is a 
block (has curly braces) within a block. 

 
Shrink the tree: 

 Choose the Utilities menu and Collapse All option to shrink the tree completely. 
 

View more detail: 

 Double click on the "+ C" line. 

 Double click on <globals> line. 

 Choose Config and then View Address Formulas.  This shows symbols with an "&" 
prefix and displays the formulas of the symbols.  These formulas are particularly useful 
for entering a symbolic name in Trigger specifications and wherever else addresses are 
used.  Use the “addressof” procedure for this.  For example, enter “addressof 
::C::FS2::MAIN::BLOCK1::x” to get the address of variable x in the first block of module 
MAIN in the FS2 module. 
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 Turn off viewing address formulas by choosing Config, then View Address Formulas. 

 Note that the Config menu has many other options.  If you turn all the options on, you will 
see all symbols in the system. 

 Close the Symbol Explorer window by choosing File, then Close. 
 

7.2.4.  Collecting Trace 

This step will show how to use the trace. 

Load the program again, which will also reset the processor and go to the start of the main procedure: 

 Choose the Tools menu in the Source window, then the Load OMF… option. 

 Use c:\Program Files\Fs2\M8051EW\samples\fs2 or wherever you installed the 
software. 

 Click OK.  You should be at line 31, the beginning of main. 
 

View Trace: 

 Choose Windows and then Trace to bring up the new window. 

 The trace appears empty.  However, the status bar indicates there are 7 frames of data 
collected.  (See bottom right of status bar; you may have to expand the horizontal size of 
the window to see this.)  The window is empty because the 7 frames are not in source 
code, the current mode chosen in the Config menu. 

 Choose Config and then Assembly in the Trace window (not the Source window).  
Notice the 7 frames.  The last line has 7:<none>:4, to indicate frame #7, <none> denotes 
it is not within a module, and 4 is the 4

th
 line of the contiguous code for frame 7.  Each 

frame displays the contiguously executed assembly instructions.  Notice a jump (djnz or 
ljmp) occurs as the last line of each frame.  The last line is a jump to address 3, which is 
the start of the main function, the result of the Run to Main on Load Source Config menu 
option. 

 
Execute code within source and see the trace collected: 

 Go to the Source window by clicking the Source window on the Windows Task bar or by 
choosing Windows menu, then Source. 

 Click the mouse on line 46 (end of while loop) and hit F6 (Go To Cursor). 

 Go back to the Trace window by clicking the Trace task bar entry or by choosing 
Windows menu, then Trace. 

 The Trace window always shows the last lines of execution which are often of most 
interest. 

 Let's view the trace as source lines, so choose Config and Source. 

 Because we ran a few lines of code you can see the entire code flow.  We set some 
globals, executed func1 which set some locals and globals and returned a value, similarly 
executed func2 and func3, and finally incremented the loopx counter. 

 Notice that line 42 with the code a = func1(loopx); appears twice, once at the end of 
frame 1 and again at the beginning of frame 3.  This is because the return from the call to 
func1 returns to the middle of line 42.  Let's confirm this by choosing Config and then 
Mixed Source/Assembly. 

 You are at the end of the buffer and there are a lot more lines because the assembly 
lines are intermixed with the source lines. 

 Scroll up to the beginning of frame 3 (line starting with 3:).  When scrolling, if you need to 
add more data to the buffer, click inside the box and use page up (or down) and line up 
(or down). 
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 The code at the beginning of frame 3 shows the a = func1(loopx); line followed by mov   
0x20,r7.  The function returns to the middle of line 42, stores the value returned in r7 in 
memory location 0x20 (variable a), and then moves on to the next source line. 

 
View source corresponding to the trace: 

 Choose Config and Source to get an easier-to-view display. 

 Click the mouse on any line and choose Utilities and then View Source. 

 The Source window shows the line that matches the trace.  You can use this on any 
source or assembly line.  If you are outside of source code (trace says <none> for 
module), the Source window will show assembly lines. 

 Close the Trace window by choosing File, then Close. 
 

7.2.5.  Setting Triggers 

This step will show how to set a hardware trigger. 

Load the program again, which will also reset the processor and go to the start of the main procedure: 

 Choose the Tools menu in the Source window, then the Load OMF… option. 

 Use c:\Program Files\Fs2\M8051EW\samples\fs2 or wherever you installed the 
software. 

 Click OK.  You should be at line 31, the beginning of main. 
 

Set up trigger: 

 Choose Windows and then Trigger to bring up the new window (see example below). 

 Set a trigger to break emulation when the loop variable, loopx, reaches 50 hex. 

 Click the Single radio button in the Trigger 1 section since we are going to set a simple 
trigger on a single address. 

 In the Address column, check Enable and type 0x26.  The address of loopx is 0x23 and 
it is a long, therefore its least significant byte is at 0x26.  (You can use the Symbol 
Explorer to get the value, or enter loopx's symbolic address adding 3 with the Tcl expr 
command.) 

 Press tab to move out of the Address entry.  This is important in order for the system to 
verify your entry and set the value. 

 In the Data column, check Enable and type 0x50 as the data we want to see for the 
variable. 

 Press tab to complete the Data entry. 

 Click the Idata Write radio button since loopx is in the internal memory space. 

 The default Action is Break, which is what we want. 
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Free run until we hit the trigger: 

 Choose Windows and then Source. 

 Click on the Go button. 

 Execution stops at line 45. 

 Double click the variable loopx on line 45 and its value will be confirmed as a long 
0x00000050.  Choose No since we don't need to watch the variable. 

 Choose Config and Mixed Source/Assembly. 

 Notice that the PC is a few lines past the actual setting of address 0x26.  This slippage is 
due to the pipelining in the CPU. 

 Choose Config and Source to return to source view. 
 

Clear the trigger: 

 Click the Off radio button in the Trigger 1 section to stop checking for the trigger. 

 Close the Trigger window by choosing File, then Close. 
 

Triggers can be set on address ranges by pairing triggers.  Data values can also be masked by 
pairing triggers.  See the online help trigger topic for more detail. 

7.2.6.  Viewing the CPU 

This step will show how to view the CPU registers, memory, and breakpoints. 
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Load the program again, which will also reset the processor and go to the start of the main procedure: 

 Choose the Tools menu in the Source window, then the Load OMF… option. 

 Use c:\Program Files\Fs2\M8051EW\samples\fs2 or wherever you installed the 
software. 

 Click OK.  You should be at line 31, the beginning of main. 
 

Change registers: 

 Choose Windows and then CPU to bring up the new window. 

 Click in the R0 register entry.  The entry is highlighted. 

 Type 0x5 and then Tab to change the value and move to the next register. 

 Notice that R0 is redrawn as 0x05.  After registers are written, they are read back. 

 R1 is now highlighted.  Type 0x12345678 and then Tab.  Notice it is truncated to 0x78. 

 As you run code, the registers are always updated whenever the processor stops. 
 

Modify memory: 

 Choose Utilities and then Goto Memory Address. 

 Type 0i and click OK to move to the internal memory data.  Suffixes are used to indicate 
the memory space.  "i" stands for internal memory, "x" is used for external memory, "p" 
(or nothing since it is the default) for program memory, and "s" for SFR space. 

 The registers are at the beginning of internal memory, so the first two (R0 and R1) 
appear as 0x05 and 0x78. 

 The cursor is at 0i from the Goto command.  Type 33.  We are in hex radix and byte size, 
so a "0x" is not shown to save space.  (See the Config menu for settings.) 

 Notice that the text appears blue as you type and returns to black after it is written to the 
hardware.  Notice also that register R0 updated since it is tied to the memory address. 

 Type 99 and see that the memory is written and R1 is updated. 

 The Utilities menu has options for searching, copying, comparing, filling, and running a 
checksum on memory. 

 
Breakpoints: 

 You can use the breakpoint pane at the bottom to set and clear breakpoints.  However, 
the easiest way to set/clear breakpoints is from the Source window.  You can double-click 
on the line number, use the Toggle Breakpoints button, the Utilities menu Set/Clear 
Breakpoint, or the context menu (right mouse) on a line. 

 Close the CPU window by choosing File, the Close. 
 

8.  Console Commands and Syntax Conventions 

In the Console window, informational messages and command output (stdout channel) are shown in 
blue, and error messages (stderr channel) in red.  Command input (stdin channel) is black.  Like Unix 
shells, the Console maintains a command history.  The command history number is shown as part of 
the prompt and previous commands can be reexecuted using the form “!1” where “1” is the command 
number, or “!!” for the previous command.  You can also use the uparrow to recall previous 
commands, and the last 10 commands are available for execution through the console‟s History 
menu. 

To abort a command in progress, hit the ESC key. 
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When the M8051EW software is started, it runs a start-up script based on information supplied to the 
Connection dialog.  See the System Navigator Quick Start Guide for more information on the System 

Navigator commands. 

configuration: m8051ew-single-core 

open server local 

open probe lpt1 oe ejtag 

tck 5000000 

jtagchain 5 

open m8051ew device, name root, type m8051ew, probe lpt1, index 0 

openport lpt1 

tapreset 

add Window menu items 

start up complete 

1> 

 

Type version to get the current version number: 

1> version 

ISA-M8051EW Debugger 

Version 2.0.0 build 0 

Copyright (C) 1998-2005 First Silicon Solutions, Inc. 

Serial number 00565 

2> 

Examine registers by typing “regs”.  Note that the registers are in their reset states (PC=0000, 
SP=07).  Note that r0-r7 are not cleared by reset, so they may not be 00. 

2> regs 

       a 00 

      r0 00 

      r1 00 

      r2 00 

      r3 00 

      r4 00 

      r5 00 

      r6 00 

      r7 00 

      pc 0000 

      sp 07 

    dptr 0000 

     psw 00 

       b 00 

      cb 00 

      eo 00 

trigtime 00000000 

3>  

 

Registers are extracted from the CPU and kept by the debugger software.  Changes to the registers 

are not actually written into the CPU until the next time the CPU is started.  The cb register is the 

current bank and represents the bank of program memory currently selected.  For non-banked 

systems, the value is zero.  eo is the Extended Operation register, normally located at 0xA2s. 

You can always return to the reset condition by typing “reset”: 

3> reset 
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User reset. 

0000p  00     nop 

4> 

 

Now assemble a program into memory: 

4> asm 0x1000p {mov dptr,#0x1234} 

3 

5> asm {movx a,@dptr} 

1 

6> asm {inc a} 

1 

7> asm {movx @dptr,a} 

1 

8> asm {sjmp 0x1003} 

2 

 

The asm command returns an integer indicating the number of bytes that were written to memory.  
Note that only the first asm command in a sequence needs to have an address specified; the asm 
address is automatically updated after each command.  The instruction text should be enclosed in 
braces to prevent Tcl from partially interpreting any special characters present. 

Now disassemble memory to verify that the correct data is present: 

9> dasm 0x1000..+0x8 

1000p  901234 mov   dptr,#0x1234 

1003p  E0     movx  a,@dptr 

1004p  04     inc   a 

1005p  F0     movx  @dptr,a 

1006p  80FB   sjmp  0x1003 

10> 

 

There are several things to note here.  To enter an address range, use the “..” operator followed by 
either the ending address in the range (e.g. 0x1000..0x1007) or a length denoted by “+” (e.g. 
0x1000..+0x8).  All numbers entered on the command line default to decimal unless preceded by “0x” 
for hexadecimal or “0” for octal.  Command output does not always include the “0x” prefix when 
showing hexadecimal values. 

The default for all memory commands is program (code) space.  To specify external data space, add 
an “x” suffix to an address.  For internal data space, use “i”.  For SFR‟s, use “s”. 

Memory may also be viewed in a number of other formats, such as: 

10> dump 0x1000..+0x8 byte 

1000p  90 12 34 E0 04 F0 80 FB  

11> dump 0x1000..+0x8 word 

1000p  9012 34E0 04F0 80FB  

12> dump 0x1000..+0x8 byte decimal 

1000p  144  18  52 224   4 240 128 251  

13> dump 0x1000..+0x8 byte octal 

1000p  220 022 064 340 004 360 200 373  

14> dump 0x1000..+0x8 byte binary 

1000p  10010000 00010010 00110100 11100000 00000100 11110000 10000000 11111011  

15> dump 0x1000..+0x8 byte ascii 

1000p  Â 4ëĄúëè 

16> dump 0x96s 

0096s  00 
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Before executing the sample program, initialize the PC and xdata memory location 0x1234: 

17> byte 0x1234x 0; pc 0x1000 

4096 

 

The reset, go, halt, bkpt, and step commands control emulation.  After a step, the current PC and the 
next instruction to be executed are displayed. 

18> step 

Single step. 

1003p  E0     movx  a,@dptr 

19> dptr 

4660 

20> format %x $dptr 

1234 

21> step 

Single step. 

1004p  04     inc   a 

22> step 

Single step. 

1005p  F0     movx  @dptr,a 

23> a 

1 

24> step 

Single step. 

1006p  80FB   sjmp  0x1003 

25> step 

Single step. 

1003p  E0     movx  a,@dptr 

26> 

 

Tcl provides a rich set of commands to test and manipulate results and control command flow.  Two 

of the most useful commands are if and while.  For example, you can set up a simple loop that 

single steps the processor until a reaches 3: 

26> while {$a != 3} {step} 

Single step. 

1004p  04     inc   a 

Single step. 

1005p  F0     movx  @dptr,a 

Single step. 

1006p  80FB   sjmp  0x1003 

Single step. 

1003p  E0     movx  a,@dptr 

Single step. 

1004p  04     inc   a 

Single step. 

1005p  F0     movx  @dptr,a 

27> a 

3 

28> 

 

Note that the registers can be accessed either using the register name command (e.g. dptr) or the 

register name variable (e.g. $dptr).  Tcl allows you to build up expressions combining variables and 

command results.  The byte and word commands return the contents of memory at the specified 

address, so target variable values can also be included in expressions.  The Tcl square bracket 
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operators are used around a command to use the command result in an expression.  Here is an 
example that steps the processor until the value in external data memory at address 0x1234 
becomes 4: 

28> while {[byte 0x1234x] != 4} {step} 

Single step. 

1006p  80FB   sjmp  0x1003 

Single step. 

1003p  E0     movx  a,@dptr 

Single step. 

1004p  04     inc   a 

Single step. 

1005p  F0     movx  @dptr,a 

Single step. 

1006p  80FB   sjmp  0x1003 

29> 

 

Software breakpoints stop emulation when executed.  Set a breakpoint using the "bkpt" command 
and run until the breakpoint is hit: 

29> bkpt set 0x1004 

0x1004p 

30> go 

Emulation started. 

Software breakpoint. 

1004p  04     inc   a 

31> 

 

The trigger command provides access to the memory breakpoint registers in the CPU.  Here is an 
example that stops emulation when the CPU writes to 0x1234x: 

31> trigger 1 -mode single -addr 0x1234 -cycle xdatawr 

-mode single -addr 0x1234 -cycle xdatawr -action break -trigout off 

32> go 

Emulation started. 

Trigger breakpoint. 

1003p  E0     movx  a,@dptr 

33> 

 

Note that breakpoints due to triggers are delayed by one or two instructions due to hardware 
pipelining.  The write that actually caused the trigger occurred at 0x1005p, and the CPU also 
executed the sjmp at 0x1006p before finally stopping. 

The Console accepts binary, Intel hex, and OMF51 format download files.  The binary format requires 
a starting address and the hex format can accept an optional base address with optional address 
space if the data is to be loaded with an offset or to a space other than program memory.  The 
command return value is the number of bytes written to memory.  The following examples illustrate 

typical uses of load: 

33> load omf "/work/stanford.omf" 

12495 

34> load hex 0x8000x "/work/xdtable.hex" 

8192 
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8.1.  Debugger Console Commands 

There are two types of commands: built-in Tcl/Tk commands and FS2-supplied commands. 

Detailed descriptions of built-in Tcl commands may be found in the online Tcl/Tk Reference Manual 
included with M8051EW software. 

Detailed descriptions of the FS2-supplied commands can be found in the online help. 
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Appendix A. AC/DC Probe Parameters 

A.1  System Navigator, Original Edition (OE) Probe 

These probe parameters are specific to the Mentor M8051EW OE hardware probe. 

DC Characteristics 

Description Symbol Min Max Unit 

Input low voltage VIL -0.5 0.8 V 

Input high voltage, TDO, RESET, TriggerOut VIH 2.0 5.5 V 

Input current, TDO, RESET, TriggerOut  (VIN 3.6V) IIL, IIH -10 +10 A 

Input voltage, VCC VVCC  5.5 V 

Input current, VCC IVCC  5.0 mA 

Input capacitance CIN  10 pF 

Output low voltage VOL 0.0 0.4 V 

Output high voltage VOH 2.4 3.5 V 

Output current IOL, IOH -12 +12 mA 
 

JTAG Switching Characteristics 

Description Symbol Min Max Unit 

Output delay from TCK falling to TDI, TMS TTCKTDI -5.0 5.0 ns 

TDO Setup time before TCK rising TTDOTCK 25  ns 

TDO Hold time after TCK rising TTCKTDO 0  ns 

TCK period TTCK 125
(1)

 DC
(2)

 ns 
 

(1)
 The TCK frequency is required to be less than the CPU clock frequency.  The 125ns period 

specification is the fastest TCK that the probe can generate. 

(2)
 TCK toggles only during JTAG transactions.  When TCK stops, it is held in the low state.  During 

JTAG transactions, the maximum TCK period generated by the debugger is 16 s.  The TCK 

period is controlled using the config TckRate command. 

TCK 

TMS,TDI 

TDO 

TTCK 

TTCKTDI 

TTDOTCK 

TTCKTDO 
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A.2  System Navigator Probe 

AC/DC parameters for the System Navigator hardware probe are generic for all cores and are 
detailed in the System Navigator Quick Start Guide. 
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Unpublished rights (if any) reserved under the copyright laws of the United States of America  
and other countries.  The copyright notices provided herein apply to the files included in this  
directory and any and all subdirectories. 
  
The files included in this directory and any and all subdirectories contain information (the  
"Information") that is proprietary to MIPS Technologies, Inc. ("MIPS Technologies").  Any  
copying, reproducing, modifying or use of the Information (in whole or in part) that is not  
expressly permitted in writing by MIPS Technologies or an authorized third party is strictly  
prohibited.  At a minimum, the Information is protected under unfair competition and copyright  
laws.  Violations thereof may result in criminal penalties and fines. 
  
Any Information provided as a document in source format (i.e., in a modifiable form such as in  
FrameMaker or Microsoft Word format) is subject to use and distribution restrictions that are  
independent of and supplemental to any and all confidentiality restrictions.  UNDER NO 
CIRCUMSTANCES  
MAY A DOCUMENT PROVIDED IN SOURCE FORMAT BE DISTRIBUTED TO A THIRD PARTY IN 
SOURCE FORMAT WITHOUT  
THE EXPRESS WRITTEN PERMISSION OF MIPS TECHNOLOGIES, INC. 
  
MIPS Technologies reserves the right to change the Information to improve function, design or  
otherwise.  MIPS Technologies does not assume any liability arising out of the application or use  
of the Information, or of any error or omission in such information.  Any warranties, whether  
express, statutory, implied or otherwise, including but not limited to the implied warranties of  
merchantability or fitness for a particular purpose, are excluded.  Except as expressly provided in  
any written license agreement from MIPS Technologies or an authorized third party, the  
furnishing of the Information does not give recipient any license to any intellectual property  
rights, including any patent rights, that cover the Information. 
  
The Information shall not be exported, reexported, transferred, or released, directly or indirectly,  
in violation of the law of any country or international law, regulation, treaty, Executive Order,  
statute, amendments or supplements thereto.  Should a conflict arise regarding the export, reexport,  
transfer, or release of the Information, the laws of the United States of America shall be the  
governing law. 
  
The Information constitutes one or more of the following: commercial computer software,  
commercial computer software documentation or other commercial items.  If the user of the  
Information, or any related documentation of any kind, including related technical data or  
manuals, is an agency, department, or other entity of the United States government  
("Government"), the use, duplication, reproduction, release, modification, disclosure, or transfer  
of the Information, or any related documentation of any kind, is restricted in accordance with  
Federal Acquisition Regulation 12.212 for civilian agencies and Defense Federal Acquisition  
Regulation Supplement 227.7202 for military agencies.  The use of the Information by the  
Government is further restricted in accordance with the terms of the license agreement(s) and/or  
applicable contract terms and conditions covering this information from MIPS Technologies or an  
authorized third party. 
  
  
 
 


